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About This Book

Welcome to the Palm™ Reader Handbook. This handbook provides information you 
need to begin using the Palm™ Reader application on your handheld to read 
eBooks and manage eBook files.

NOTE Your handheld may include a navigator button you use to open dialog boxes 
and to select items, and a Graffiti® 2 writing area or keyboard you use to open menus, 
enter text, and select items. These actions are described generically throughout this 
handbook. See your handheld handbook for more information on how to perform 
these actions.

This book walks you through the following:

■ Quick Reference for Palm Reader

■ Obtaining and installing eBooks on your Palm OS® handheld

■ Opening and reading eBooks

■ Turning pages and navigating to other locations in eBooks

■ Using the toolbar and Go menu

■ Creating, using, and deleting bookmarks

■ Creating, using, deleting, and exporting notes

■ Using Auto Scroll

■ Viewing book information

■ Using categories to organize eBooks

■ Copying, deleting, and beaming eBooks

■ Customizing the Palm Reader application
1
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CHAPTER 1

Obtaining and Installing eBooks

The Palm™ Reader application allows you to read eBook files on your Palm OS® 
handheld. It displays the contents of eBook files on your handheld’s screen in a 
page-by-page format, as paper books do; provides methods for navigating quickly 
and easily in eBooks with support for embedded hyperlinks and images; includes 
options for managing eBook files; and allows you to save bookmarks and add 
notes to pages.

System requirements
To use the Palm Reader application, you need the following:

■ A Palm OS handheld running Palm OS 3.0 or later

■ A Windows or Mac computer with the Palm™ Desktop software 

If you intend to download eBooks, you must also have:

■ A web browser installed

■ Internet access

Installing Palm Reader
To use Palm Reader, you must install the software files located on the Software 
Essentials CD-ROM.

To install Palm Reader (Windows):
1. Insert the Software Essentials CD-ROM into your computer’s CD-ROM drive.

2. From the categories listed on the left side of the Install screen, click the 
Entertainment tab, and then click Palm Reader.

3. Click Install Now to send the files to Palm™ Quick Install.

NOTE If Palm Quick Install is not already open, a confirmation dialog box will 
appear. In the User drop-down list, select the name that corresponds to your 
handheld. Click OK to send the files to Palm Quick Install. 

4. Connect your handheld to the cradle/cable and press the HotSync® 
button ™.
3



Chapter 1 Obtaining and Installing eBooks
To install Palm Reader (Mac computer):
1. Insert the Software Essentials CD-ROM into your computer’s CD-ROM drive. 

2. Double-click the Software Essentials CD, open the Entertainment folder and 
then open the Palm Reader folder.

3. Select all files except the handbook, and then double-click.

4. In the User drop-down list, verify that the user name corresponds to your 
handheld.

NOTE If the user name is not correct, reselect the files you selected in step 3 
and then click Remove from List. Select the correct name and then begin again 
from step 3.

5. Connect your handheld to the cradle/cable and press the HotSync button .

Obtaining eBooks
eBooks are available from Palm, Inc. 

To obtain eBooks from the Internet:
1. Use your web browser to go to www.palmsource.com, and then click eBook 

Library.

2. Locate an eBook you want, pay for the book if necessary, and download it to 
your computer.

NOTE You’ll need to be able to find the file after you’ve downloaded it, so be 
sure to specify a folder on your computer, such as the desktop, that you can 
find easily.

Installing eBooks
Installing eBooks on your handheld or expansion card is similar to installing an 
add-on application. Add the eBook file to the queue of files to be copied or updated 
the next time you perform a HotSync operation.

To see the installed eBooks, start the Palm Reader application. See “Opening and 
switching between eBooks” in Chapter 2.
4

http://www.palmsource.com
http://www.palmsource.com
http://www.palmsource.com


Installing eBooks
To install eBooks using a Windows computer:
1. Copy or download the eBook file(s) you want to install on your computer.

2. Double-click the Palm Quick Install icon on the Windows desktop.

.

3. In the User drop-down list, select the name that corresponds to your handheld.

4. Click Add.

TIP To install a folder, open the File menu and select Add Folder.

5. Select the eBook file(s) that you want to install.

If you do not see the eBook file(s) in the default folder, navigate to the folder that 
contains the eBook file(s) that you want to install.

TIP You can also install eBooks in other ways: by double-clicking the eBook 
file(s); by right-clicking the eBook file(s) and sending them to Palm Quick Install; 
or by opening the Palm Quick Install window and dragging and dropping the 
eBook file(s) to the handheld file list or the expansion card file list. 

6. Click OK.

7. If you need to change the destination of the eBook file(s) you are installing, drag 
the files to move them between the handheld and the expansion card file list.

8. Perform a HotSync operation to install the selected eBook file(s). 

To install eBooks using a Mac computer:
1. Copy or download the eBook file(s) into the Add-on folder in your Palm folder. 

(If the file is compressed, expand it into this folder.)

2. Double-click the HotSync Manager icon in the Palm folder.

3. From the HotSync menu, select Install Handheld Files.

4. From the User pop-up menu, select your user name.

User 
drop-down 
list

Add button
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Chapter 1 Obtaining and Installing eBooks
5. Click Add to List.

6. Select the eBook file(s) that you want to install.

7. Click Add File to add the eBook file(s) to the Install Handheld Files list.

TIP You can also drag eBook files to the list in the Install Handheld Files dialog 
box. The eBook files are copied to the Files To Install folder.

8. If you need to change the destination of the eBook file(s), click Change 
Destination in the Install Handheld Files window, and then use the arrows to 
move the eBook file(s) between your handheld and an expansion card. Click OK 
to close the Change Destination window.

9. Close the Install Handheld Files window.

10. Perform a HotSync operation to install the eBook file(s) on your handheld or 
expansion card.

Quick Reference
This section provides a way for you to quickly familiarize yourself with the Palm 
Reader functions.

The navigator button allows you to move up and down in menus and pick lists, 
and right and left between menus, without using the stylus. You can scroll down 
to view information below the viewing area, and scroll up to view information 

Tap to go to a particular page.

Back button for eBooks with hyperlinks.
Current time.

Information about this book.
Invert display (white ink on black background).

Add a note on this page.
Go to or add a bookmark for this page.

Table of Contents for this eBook.

Tap the bookmark to remove it. If there is no bookmark, 
tapping here adds a bookmark.

Tap top half of screen to move up one page.

Tap bottom half of screen to move down one page.
6



Quick Reference
above the viewing area. The center button, Select, allows you to select items in 
dialog boxes and menus.

 

■ Select: Select inserts the highlight in lists; opens a highlighted item; closes most 
dialog boxes that contain a Done or OK button; and sets a bookmark on the 
current page, or clears it if one already exists. Holding down the Select button 
will return you to the Applications Launcher.

■ Up/Left: Go to the previous page in the eBook you are reading.

■ Down/Right: Go to the next page in the eBook you are reading.

■ In menus: After you open the menus, press Right and Left on the navigator to 
move between menus, press Down on the navigator to select the command you 
want to use, and then press Select on the navigator to run the command.

Look for the navigator icon to find navigator tips throughout this handbook.

Navigator
7
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CHAPTER 2

Using the Palm™ Reader Application

Once you’ve installed one or more eBooks on your handheld, you’re ready to start 
reading using the Palm™ Reader application.

Opening and switching between eBooks
To see the installed eBooks, open the Palm Reader application. 

The first time you open the Palm Reader application, it displays the Open dialog 
box with a pick list of the installed eBooks. The Open dialog box is also displayed 
if you previously opened the application but did not open an eBook.

If you previously opened the Palm Reader application and an eBook, the page of 
the eBook most recently viewed is displayed. 

To open the Palm Reader application and an eBook:
1. Open the Applications Launcher.

TIP Press and hold Select on the navigator to open the Applications Launcher. 

2. Tap the Palm Reader icon .

NOTE The Card icon  displayed to the right of an eBook name indicates that 
the eBook is on an expansion card.

3. Select the name of the eBook you want to read in the pick list, and then tap 
Open. 
9



Chapter 2 Using the Palm™ Reader Application
The contents of the eBook file determine what is displayed first when the eBook is 
opened. This might be a picture of the book cover, a title page, a table of contents, 
or the first page of text.

To open or switch to another eBook:
1. Open the menus.

2. Tap Book, and then tap Open.

3. Select the name of the eBook you want to read, and then tap Open.

Using hyperlinks and images
Most eBook pages will have plain text for reading. However, there are two other 
types of content you may encounter:

■ Hyperlinks

■ Images

Hyperlinks
Hyperlinks appear as areas of underlined text. They are linked to another place in 
the eBook. When you tap a hyperlink, you jump to that place.

Not all eBooks have hyperlinks.

To use hyperlinks to navigate: 
1. Tap a hyperlink to go directly to the hyperlink’s target. 

2. Tap the Back icon  in the toolbar to return to your previous place.

Images
Images that fit on the screen are displayed inline with text. Images that are larger 
than the screen are indicated with a thumbnail icon.
10



Turning pages
To display and view large images:
1. Tap the thumbnail icon .

2. Drag the opened image with the stylus.

3. To zoom an image, press the Up and Down buttons on the navigator.

4. Tap any icon except the Home icon  to exit the image viewer. If your 
handheld has a keyboard, press any key except Home. 

Turning pages
The Palm Reader application displays eBooks page by page. (An eBook page 
contains the amount of text that can be displayed at one time.) You can turn pages 
one at a time or jump to a particular page.

Turning one page at a time
You can turn one page at a time using the navigator.

To turn to the next page:
■ Press Down on the navigator.

To turn to the previous page:
■ Press Up on the navigator.

You can also tap the screen to turn the page. When tapping the screen to turn a 
page, don’t tap the following items. If you do, you will jump to a different part of 
the eBook.

■ Hyperlinks: Areas of underlined text linked to another place in the eBook. See 
“Hyperlinks” earlier in this chapter for more information. 

■ Bookmarks: A page marked by a turned-down corner in the upper-right corner 
of the text screen. See “Using bookmarks” later in this chapter for more 
information. 

Jumping to a particular page
There are several Palm Reader features that allow you to jump to a particular place 
in an eBook: 

■ Progress bar: Tap the progress bar located in the lower-right corner of the 
screen, enter the page number you want to turn to, and then tap OK. You can 
also drag the edge of the progress bar until the page you want is indicated, and 
then tap OK.
11



Chapter 2 Using the Palm™ Reader Application
■ Toolbar icons: There are four icons in the toolbar that allow you to navigate in 
an eBook: Contents, Bookmarks, Notes, and Back. See “Using the toolbar” later 
in this chapter for more information on the toolbar and its uses.

■ Hyperlinks: Tapping a hyperlink takes you directly to that part of the eBook. See 
“Hyperlinks” earlier in this chapter for more information.

■ Navigation options in the Go menu: There are five options in the Go menu that 
allow you to navigate in an eBook. See “Using Go menu commands to navigate” 
later in this chapter for more information on those options.

Using the toolbar
The toolbar is located in the lower-left corner of the screen. It contains up to seven 
icons, each relating to a particular function. 

Each toolbar icon can be enabled or disabled in the Palm Reader Preferences dialog 
box. See “Toolbar Preferences” in Chapter 4 for how to turn the toolbar icons on 
and off. 

Most functions controlled by toolbar icons have equivalent menu items, many of 
them on the Go menu. 

NOTE The Clock/Battery icon has no menu equivalent. 

To use the toolbar, tap one of the following icons:

■ Contents icon : Displays the Table of Contents of the open eBook. Select an 
item in the Contents pick list. Tap Info to view page information on the chapter 
or section you selected. Tap Go To to jump to that place in the eBook. The menu 
equivalent for the Contents icon is Go To Chapter on the Go menu. 

■ Bookmarks icon : Displays the Bookmarks dialog box. See “Using 
bookmarks” later in this chapter for more information on bookmarks and on 
using this dialog box. The menu equivalent is Bookmarks on the Go menu. 

■ Notes icon : Displays the Notes dialog box. See “Using notes” later in this 
chapter for more information on notes and on using this dialog box. The menu 
equivalent is Notes on the Go menu. 

■ Invert Screen : Toggles the page display between black on white and white on 
black. The menu equivalent is Invert Screen on the Options menu. 

■ Information icon : Displays the Book Info dialog box. See “Viewing book 
information” in Chapter 3 for more information. The menu equivalent is Book 
Info on the Options menu. 

■ Clock/Battery icon : Displays the time and battery charge state. 

■ Back icon : Returns you to where you were in the eBook prior to tapping a 
hyperlink. The menu equivalent is Back on the Go menu. 
12



Using Go menu commands to navigate
Using Go menu commands to navigate
The Go menu contains several command options that allow you to navigate in an 
eBook.

To use Go menu commands to navigate:
1. Open the menus.

2. Tap Go, and then tap one of the following commands:

Using Find and Find Again
If you want to search for specific text, use the Find and Find Again commands.

NOTE When you tap Find on the Go menu, a dialog box is displayed, which warns 
you that searching for text in large books can be time-consuming. You can disable the 
Display Find Warning dialog box in the Palm Reader Preferences dialog box. 

To find specific words anywhere in an eBook:
1. Open the menus.

2. Tap Go, and then tap Find.

3. Enter the text you want to find in the Find field.

To find the text anywhere in the entire eBook, leave the check box deselected. To 
find the text between the current page and the end of the book, tap the check 
box to select it.

4. Tap Find.

To repeat the search for the same text, use the Find Again command on the 
Go menu.

Go To Page Displays the progress bar dialog box. Enter the page 
number you want to go to. You can also drag the edge of the 
progress bar until the page number you want is indicated. 
Then tap OK. 

Go To Chapter Displays the Table of Contents for the open eBook. Select an 
item in the Contents pick list, and then tap Go To.

Go To Beginning Takes you to the beginning of the eBook.

Go To End Takes you to the end of the eBook.

Back Takes you back to where you were in eBook before tapping 
a hyperlink.
13



Chapter 2 Using the Palm™ Reader Application
Using bookmarks
Bookmarks allow you to mark a place in an eBook much like you would insert a 
paper bookmark in a conventional book. You can use a bookmark to jump to 
that page.

Creating bookmarks
When you create a bookmark, it shows up as a folded corner at the upper-right 
corner of the page. The quickest and easiest ways to create a bookmark are to use 
the navigator, or just tap the upper-right corner of the page.

To create a bookmark without leaving the text screen:
■ Press Select on the navigator to set a bookmark on the current page. 

NOTE If a bookmark already exists on the current page, pressing Select on the 
navigator deletes the bookmark.

Finding bookmarks
You use bookmarks to find a place quickly in an eBook. The easiest way to find a 
bookmark is to tap the Bookmarks icon.

To find a bookmark:
■ Tap the Bookmarks icon  in the toolbar.

Deleting bookmarks
The easiest ways to delete a bookmark you no longer need are to tap the bookmark 
or use the navigator.

To delete the bookmark on the text screen:
■ Press Select on the navigator to delete the bookmark on the current page. 

NOTE If there is no bookmark on the current page, pressing Select on the navigator 
adds a bookmark.
14



Using notes
Using notes
NOTE Notes were formerly called annotations.

Notes mark eBook text with commentary. Like with a bookmark, you can use notes 
to jump directly to a page. 

You can export notes to a file that can be read in Memo Pad. This feature allows 
you to take notes on an eBook and export them as a single file. See “Exporting 
notes” later in this section.

When you are on a page that has a note, you will see the Notes icon in the toolbar 
change from  to . Tapping the right side of this icon displays the notes.

Creating notes
You create notes similar to the way you create bookmarks. The easiest way to create 
a note is to tap the Notes icon .

To create a note:
1. Tap the Notes icon  in the toolbar, if it is displayed. See “Palm Reader 

Preferences” in Chapter 4 for how to turn the toolbar icons on and off.

2. Enter a note name or accept the default and enter commentary up to the 
maximum of 1024 characters per note.

3. Tap Done. Tap Delete to exit without adding a note.

Viewing, editing, and finding notes
You can select, view, and edit notes. Then you can exit the note or go directly to that 
page. The easiest way to work with notes is to tap the Notes icon .

To view, edit, or find a note:
1. Tap the Notes icon .

2. Select a note from the pick list, and then tap View.
15



Chapter 2 Using the Palm™ Reader Application
3. (Optional) Edit the note name or note. 

4. Tap one the following commands:

Deleting notes
You delete a note similarly to the way you view or go to a note.

To delete a note:
1. Tap the Notes icon .

2. Select a note from the pick list, and then tap Delete.

3. Tap Delete again.

Exporting notes
The Export Notes feature allows you to save the contents of all your notes for an 
eBook in one record. The record is stored in Memo Pad for convenient review. 
When you open a note file in Memo Pad, you see the assigned page number for 
each note, followed by the text you entered. 

To export notes to a memo:
1. Open the menus.

2. Tap Book, and then tap Export Notes.

The memo containing all the notes from the currently open eBook is created and 
assigned a name starting with Notes, followed by the name of the eBook from 
which the notes were exported.

Using Auto Scroll
Auto Scroll allows you to read a book without having to manually turn pages. 
When you enable Auto Scroll, the text of the book scrolls up the screen at a speed 
that you can easily adjust at any time.

See “Auto Scroll Preferences” in Chapter 4 for how to set the scrolling speed for 
Auto Scroll.

To start Auto Scroll:
1. Open the menus.

2. Tap Options, and then tap Start Auto Scroll.

NOTE While Auto Scroll is enabled, the toolbar is not displayed.

Done Save your changes (if any) and exit back to the text screen.

Go To Save your changes (if any) and go to the place marked by 
the note.
16



Using Auto Scroll
To adjust the Auto Scroll speed while reading:
■ Press Up on the navigator to increase the speed of Auto Scroll.

■ Press Down on the navigator to decrease the speed of Auto Scroll. 

To stop Auto Scroll:
■ Tap anywhere on the text screen while reading.
17
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CHAPTER 3

Managing eBooks

This chapter explains how to manage eBook files on your handheld using the 
following Palm™ Reader features:

■ Book Info: View information about the currently open eBook.

■ Edit categories: Use categories to organize eBooks. 

■ Memory information: Find out how much memory an eBook is using. 

■ Copy and Delete: Copy or delete an eBook from your handheld’s memory or 
expansion card.

■ Beam: Beam an eBook from your handheld to another handheld.

Viewing book information
This section describes how to view Book Info. This dialog box includes page count 
and category information. 

There is another Info option, different from the Book Info command, that you can 
view by tapping Open, Delete, Beam, or Copy on the Book menu. It displays 
memory information about the currently open eBook. See “Finding out how much 
memory an eBook uses” later in this chapter for more information. 

To view book information:
1. Tap the Info icon  in the toolbar.

2. View the title and page information for the open eBook and the category the 
eBook is filed in. See “Using categories” later in this chapter for more 
information on categories.
19



Chapter 3 Managing eBooks
NOTE If the Private option is selected, the eBook is a private record. When 
Hide Records is selected for the handheld, a private eBook is not displayed in 
eBook pick lists.

3. (Optional) Tap Help to view Help information, and tap Done when finished.

4. Tap OK or Cancel. 

NOTE If you changed the Category or Private setting, you must tap OK to save 
the changes.

Finding out how much memory an eBook uses
Knowing how much memory an eBook uses can help you determine which eBooks 
to keep on your handheld and which ones to delete or move to an expansion card.

To find out how much memory an eBook is using:
1. Open the menus.

2. Tap Book, and then tap any of the following options: Open, Delete, Beam, 
or Copy.

NOTE If you don’t have an expansion card, you will not see the Copy 
dialog box.

NOTE This example shows the Open dialog box. 

3. Select the name of an eBook, and then tap Info.

The memory size of the selected book and the amount of free memory on your 
handheld or expansion card are displayed. 

4. Tap OK.

5. Tap Cancel.
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Using categories
You can add new categories, edit categories, and delete categories. Then you can 
assign eBooks to categories or move them from one category to another. 

To add a new category, rename a category, or delete a category:
1. Open the menus.

2. Tap Options, and then tap Book Info.

3. Tap the down arrow next to Category.

4. Tap Edit Categories in the category list.

5. Tap one of the following options:

To change the category of an eBook:
1. Open the menus.

2. Tap Options, and then tap Book Info.

New Adds a new category. Enter the new category name, and then 
tap OK.

Delete Deletes the selected category. When you tap Delete, the category 
is immediately deleted. If the category has eBooks in it, they are 
reassigned to the Unfiled category. 

Rename Renames the selected category.
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3. Tap the down arrow next to Category.

4. Tap the name of the category you want to move the eBook into, and then 
tap OK.

Copying an eBook
Expansion cards allow you to store eBooks for later use. Copy any eBook you want 
to store on an expansion card, and then open and read the copy on your handheld 
or on another handheld. 

Once the eBook file is copied to the expansion card, you can see it in the pick lists 
in the Open, Delete, Beam, and Copy dialog boxes. To indicate that the eBook is on 
an expansion card, the Card icon  is displayed to the right of the eBook name.

To copy an eBook to an expansion card:
1. Open the menus.

2. Tap Book, and then tap Copy. 

NOTE The Copy option appears on the menu only if you have an expansion 
card inserted.

3. Select the name of the eBook you want to copy from the pick list, and then 
tap Copy.

NOTE If the eBook you are copying originates on the handheld, it is copied to 
the expansion card automatically. If the eBook you are copying originates on 
the expansion card, it is copied to the handheld.
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Deleting an eBook
When you no longer have a need for an eBook on your handheld, it is a good idea 
to delete it to conserve memory on your handheld.

To delete an eBook,
1. Open the menus.

2. Tap Book, and then tap Delete.

NOTE The Card icon  displayed to the right of an eBook name indicates the 
eBook is on an expansion card.

3. Select the name of the eBook you want to delete, and then tap Delete.

4. Tap Delete again.

Beaming an eBook to another handheld
You can beam an eBook from your handheld to another Palm OS® handheld as 
long as it is not protected by a password. Password-protected eBooks cannot be 
beamed.

To beam an eBook that is not password protected:
1. Open the menus.

2. Tap Book, and then tap Beam.

3. Select the name of the eBook you want to beam, and then tap Beam.

NOTE The receiving handheld must have Beam Receive on in the Power 
Preferences screen, or in the General Preferences screen, depending on which 
handheld you own.

4. When the Beam dialog box appears, point the IR port of your handheld directly 
at the IR port of the receiving handheld. Wait for the dialog box to indicate that 
the transfer is complete before you continue working on your handheld. 
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CHAPTER 4

Customizing the Palm™ Reader Application

There are several features you can use to customize the Palm™ Reader application 
to look and work the way you prefer. This chapter explains how to find and change 
these settings: 

■ Display of warnings and toolbar icons

■ Audible tapping sounds

■ Page tapping 

■ Screen orientation

■ Quality of images and rate of page turning

■ Font size

■ Black-on-white or white-on-black screen text 

■ Auto Scroll speed

Selecting Options
You access the customizing features through the Options menu. 

To open the Options menu:
1. Open the menus.

2. Tap Options, and then tap one of the following options:

General Preferences Displays the Palm Reader Preferences dialog box. See 
“Palm Reader Preferences” later in this chapter for 
more information.

Toolbar Preferences Displays the Toolbar Preferences dialog box. See 
“Toolbar Preferences” later in this chapter for more 
information.

Screen Preferences Displays the Screen Preferences dialog box. See 
“Screen Preferences” later in this chapter for more 
information.

Font – Small Tap to display the text of an open eBook in small font. 
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Palm Reader Preferences
The Palm Reader Preferences dialog box allows you to control whether certain 
warning screens are displayed. You control audible tapping from this dialog box 
as well.

NOTE All of the settings shown in this example are the default settings.

■ All Sound Off (Master): Controls only the sounds that the handheld makes for 
the Palm Reader application. These sounds include tapping the screen, tapping 
in the Graffiti® writing area if your handheld supports Graffiti writing, and the 
beep made by pop-up dialog boxes. This option allows you to run the Palm 
Reader application silently.

■ Allow Screen Page Tapping: Controls whether tapping on the text portion of the 
screen turns the page. If you deselect this setting, you must use the Up/Left and 
Down/Right buttons on the navigator to turn pages.

NOTE When this setting is deselected, the icons in the toolbar and hyperlinks 
still respond to taps.

■ Audible Page Tapping: Controls whether tapping on a page makes a sound. If 
this setting is deselected, page tapping to turn pages still works, but there is no 
sound to accompany each tap. Sounds are still generated when you tap a 
toolbar icon or one of the icons in the Graffiti writing area, if your handheld 
supports Graffiti writing.

Font – Large Tap to display the text of an open eBook in large font.

Invert Screen Tap to change the text screen from black-on-white text 
to white-on-black, or vice versa. This option is 
convenient for night-time reading.

Auto Scroll Preferences Displays the Auto Scroll Preferences dialog box. See 
“Auto Scroll Preferences” later in this chapter for more 
information.
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■ Display Find Warning: Controls the display of the Find Warning dialog box, 
normally displayed when you start a search for text using Find (in the Go 
menu).

NOTE Tapping Never Warn in the Find Warning dialog box also turns off the 
Find Warning. Once it is turned off, you must use the Display Find Warning 
check box in the Palm Reader Preferences dialog box to turn it back on.

■ Display Image Viewing Warning: Controls the display of the Image Viewing 
Warning dialog box, normally displayed when an image in an eBook is 
displayed.

NOTE Tapping Never Warn in the Image Viewing Warning dialog box also 
turns off the Image Viewing Warning. Once it is turned off, you must use the 
Display Image Viewing Warning check box in the Palm Reader Preferences 
dialog box to turn it back on.

■ Display Conversion Warning: Controls whether you see a warning about 
updating the format of your bookmarks and annotations when upgrading from 
an old version of Palm Reader. If this setting is not selected, you will not see this 
warning and the conversion will automatically take place.

Toolbar Preferences
The Toolbar Preferences dialog box allows you to select which icons appear in the 
toolbar in the lower-left corner of the screen. Most of the toolbar items have menu 
equivalents.

See “Using the toolbar” in Chapter 2 for information on how to use the toolbar 
icons.
27



Chapter 4 Customizing the Palm™ Reader Application
Screen Preferences
The Screen Preferences dialog box contains settings that control the way text is 
displayed on the Palm Reader screen: the direction of text, where you page-tap to 
turn pages, and the display quality. 

■ Screen Orientation: Allows you to choose the direction for the eBook text 
display. Four icons show how you hold the handheld to read the text. The third 
icon shows landscape mode, which has the handheld’s buttons on the right. 
Landscape orientation is particularly useful for a right-handed person reading 
with one hand.

NOTE The functions for the buttons on the navigator are automatically rotated 
if you change the orientation in which you’re reading the pages. 

■ Page-tapping: Controls where you tap on the screen to turn pages. The icon on 
the left sets Page-tapping so that a tap on the lower half of the screen takes you 
to the next page, and a tap on the upper half of the screen takes you to the 
previous page. The icon on the right sets Page-tapping so that a tap on the right 
side of the screen takes you to the next page, and a tap on the left side of the 
screen takes you to the previous page.

■ Display Quality: Allows you to choose between high-quality images combined 
with slower page turning and low-quality images combined with faster page 
turning. 
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Auto Scroll Preferences
Auto Scroll allows you to read a book without having to manually turn pages. This 
section explains how to set the scrolling speed for Auto Scroll. See “Using Auto 
Scroll” in Chapter 2 for information on how to use Auto Scroll.

■ One Pixel: Sets the scrolling speed to minimum.

■ Small Font: Sets a speed that is appropriate if the screen is configured to use the 
small screen font. 

■ Large Font: Sets a speed that is appropriate if the screen is configured to use the 
large screen font.

NOTE When you tap One Pixel, Small Font, or Large Font, the value in the field above 
changes. You can manually adjust the scrolling speed by entering a number in this 
field. 
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